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Cautions
• No part of this document may be reproduced, stored in a retrieval system, or transmitted in any form 

or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 

written permission of Seiko Epson Corporation.

• The contents of this document are subject to change without notice. Please contact us for the latest 

information.

• While every precaution has taken in the preparation of this document, Seiko Epson Corporation 

assumes no responsibility for errors or omissions.

• Neither is any liability assumed for damages resulting from the use of the information contained 

herein.

• Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third 

parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of: 

accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this 

product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating 

and maintenance instructions.

• Seiko Epson Corporation shall not be liable against any damages or problems arising from the use of 

any options or any consumable products other than those designated as Original EPSON Products or 

EPSON Approved Products by Seiko Epson Corporation.

Trademarks
EPSON® and ESC/POS® are registered trademarks of Seiko Epson Corporation in the U.S. and other 

countries.

MS-DOS®, Microsoft®, Win32®, Windows®, Windows Vista®, Windows 7TM, Windows Server®, Visual Stu-

dio®, Visual Basic®, Visual C++®, and Visual C#® are either registered trademarks or trademarks of 

Microsoft Corporation in the United States and other countries. 
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For Safety

Key to Symbols

The symbols in this manual are identified by their level of importance, as defined below. Read 
the following carefully before handling the product.

Restriction of Use
When this product is used for applications requiring high reliability/safety such as 
transportation devices related to aviation, rail, marine, automotive etc.; disaster prevention 
devices; various safety devices etc; or functional/precision devices etc, you should use this 
product only after giving consideration to including fail‐safes and redundancies into your 
design to maintain safety and total system reliability. Because this product was not intended for 
use in applications requiring extremely high reliability/safety such as aerospace equipment, 
main communication equipment, nuclear power control equipment, or medical equipment 
related to direct medical care etc, please make your own judgment on this product’s suitability 
after a full evaluation.

Provides information that must be observed to avoid damage to your equipment or a 
malfunction.

Provides important information and useful tips.
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About this Manual

Aim of the Manual

This manual is aimed to provide all the necessary information for development engineers to 
develop, design, and install POS system, or to develop and design printer applications.

Manual Content

The manual is made up of the following sections:

Chapter 1 Overview

Chapter 2 How to Use the Printer Driver

Chapter 3 Reference

Chapter 4 Utility

Chapter 5 PRINTER_INFO_2

Appendix Specification
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Overview
Introduction

The Advanced Printer Driver (APD) is a Windows driver for the EPSON TM printers. Using the 
Status API, the APD also can be used to monitor the TM printer status in your POS system. 
TM‐C100 printer driver is designed specifically for the TM‐C100 printer. 

Manual organization

Install Manual
Descriptions of the procedures from installing the APD to performing test print, adding printer 
drivers, and the silent install which is an automated APD installation. 

TM/BA/EU Printer Manual
Descriptions of how to use the APD and its functions. 

Printer Specification
Descriptions of the specifications of each printer driver.

TM-C100 Manual
This manual. Descriptions of how to use the TM‐C100 printer driver and its functions.

Customer Display Manual
Descriptions of how to use the Customer Display printer driver and its functions.

Status API Manual
Descriptions of how to get the status of the TM printer from the user application by using the 
Status API. 
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Devmode API / PRINTERINFO Manual
Descriptions of how to configure some printer functions on your application using the Devmode 
API. Descriptions of the PRINTERINFO Function of Windows. 

Inquiries
See the Epson home page.

• For customers in North America, go to the following web site. 
http://www.epsonexpert.com/ 

• For customers in other countries, go to the following web site. 
http://www.epson‐pos.com/
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TM-C100 printer driver Features 

TM-C100 Features
• Print data is created on an application and Windows just like the other general printers. 

• TM‐C100  is not  equipped with TM printer  special  functions  such  as device  fonts, barcode 
fonts, and control fonts. 

• TM‐C100 has two models; Color (full‐color with 4 color ink) model and monochrome model. 
The TM‐C100 printer driver supports both of the two models. 

• The color model allows the user to select paper type from plain paper, special fine paper, and 
special matte paper. (ʺPaperʺ on page 24)

Convenience 
• When using roll paper, the roll paper can be cut precisely with the autocutter. 

(ʺPaperʺ on page 24)

• A4‐size document can be automatically reduced so that it fits within the paper width.   
(ʺLayoutʺ on page 31)

Printer status check
• The Status Viewer allows you to display printer status or ink information just by installing the 

printer driver. 

• Status API can be used. Using the Status API, you can develop your application to monitor the 
printer status. (Win32 and .NET environments are supported.)

Utility
• The Nozzle Check utility prints a nozzle  check pattern and you can detect  clogging of  the 

nozzles on the print head. And ink clogging can be removed by operating the Head Cleaning. 
(ʺNozzle Check Utilityʺ on page 45)

• Allows you to adjust minutely the position to print by Top‐Margin Correction, Right‐Margin 
Correction and Adjust LR. (ʺTop‐Margin Correction Utilityʺ on page 48)

• The Status Viewer and Status API cannot be used when connecting using the Standard 
TCP/IP port. Updating of PRINTER_INFO status also cannot be made.

• In Terminal Service / Citrix XenApp environment, Status API and PRINTER_INFO_2 
cannot be used.
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Installation
• Allows you to copy the existing settings of the APD environment to other computers. 

(Silent Install) 

• After  the APD  is  installed,  the  printer  driver  is  automatically  installed  by  Plug  and  Play 
function. 

Supported Operation Systems
See the operating environment in the Install Manual for supported OS.

Compatibility 
• Note that APD 4.xx cannot coexist with APD 2.xx or 3.xx. 

• Coexistence with OPOS in a computer is not possible.

Using the TM-C100 printer driver
Just like commercially available inkjet printers, select the TM‐C100 printer driver from an 
application to perform a print job. 

Differences Depending on the OS
The content of the descriptions of some operations in this book may be different depending on 
the OS. See the following.

• When you install APD 4.xx in an environment in which APD 2.xx or 3.xx is already 
installed, APD first automatically uninstalls the previous version before installing 4.xx

• APD 4.xx does not support some TM printers. Check that your TM printer is, in fact, 
supported by APD 4.xx. If you install APD4.xx in an environment featuring an 
unsupported TM printer, then you will no longer be able to use that TM printer. 

Tab Description
Screens shown Screens in Windows Vista are used for the descriptions in this manual.

Setting a printer 
driver

Windows 7 
[Start] - [Control Panel] - [Hardware and Sound] - [Devices and Printers] 
Right click the printer driver, and select the [Printer properties].

Windows Vista 
[Start] - [Control Panel] - [Hardware and Sound] - [Printer] 
Right click the printer driver, and select the [Properties].

Windows XP 
[Start] - [Control Panel] - [Printers and Faxes] 
Right click the printer driver, and select the [Properties].
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How to Use the Printer Driver
This chapter explains how to use the TM‐C100 printer driver.  
Just like commercially available inkjet printers, select the TM‐C100 printer driver from an 
application to perform a print job. 

Displaying the printer driver configuration screen
To open the setting screen of the printer driver Properties, right click the printer driver from 
[Start] ‐ [Control Panel] ‐ [Printers] and select [Properties] (Reference page of other OS.).  
Select the [General] tab on the Properties screen and click the [Printing Preferences...] button to 
open the Printing Preference screen.

If you replace one TM-C100 with another TM-C100 when you have logged on to your 
computer as a user with administrative rights (a user belonging to the Administrators 
group), the printer may not operate correctly. In this case, restart your computer.

All the screenshots used throughout this manual were captured on Windows Vista. If you 
are using another OS, the screenshots may slightly differ from the screens displayed on 
your computer, however, the setting items and procedures themselves are the same.

Properties Printer driver configuration screen
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Making settings required before first use
The first thing to do before using the printer driver is to select the printer model and the paper 
feed method.

Printing Preferences settings

In the Printing Preferences screen you can select the printer model and the paper feed method. 
Click on the [Option] tab to display the following screen.

Selecting the printer model
In the Printer Color Specification box, select Color or Black that matches your printer model.

When this setting is changed, the following message is displayed. Make sure your selection 
matches your printer, and then press the [OK] button. The change is accepted and enabled. 

Printer model Printer Color Specification
Color model Select "Color".

Monochrome model Select "Black".
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Selecting an option paper feeder 
In the Paper Source Option box, select one of the options that matches the option paper feeder of 
your printer.

Make sure to select Color or Black correctly so that it matches your printer specification. If 
you make a wrong setting, your printer will not work normally. 

When the Printer Color Specification setting is changed, the following settings on the [Main] 
tab are also changed. 
(ʺMainʺ on page 21)
• Media Type
• Color
• Mode

Option feeder of your 
printer

Paper Source Option

Auto sheet feeder Select "Auto Sheet Feeder".

Roll paper holder Select "Roll Paper Holder".

No options Select "None".

Make sure to select the option correctly so that it matches your printer. If you make a wrong 
setting, your printer will not work normally. 

• When the Paper Source Option setting is changed, the following settings on the [Paper] 
tab are also changed. 
(ʺPaperʺ on page 24)

• When the Paper Size/Page Size setting exceeds the available range of the selected 
Paper source, the following message is displayed. (ʺPaper setting confirmationʺ on 
page 29)
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Using the Status Viewer
The Status Viewer allows you to check printer status, error or ink information on your computer. 
No other special application is required for monitoring the printer status. 
For more details about the Status Viewer, see ʺEPSON Status Viewerʺ on page 38.

Installing the Status Viewer

The Status Viewer is installed together with the TM‐C100 printer driver. 

Activating the Status Viewer

The Status Viewer is automatically activated when you login a computer on which the TM‐C100 
printer driver is already installed. 
While the Status Viewer is activating, the icon is displayed on the task tray. The blue icon shown 
below appears while the connected TM‐C100 printer is powered. 

When the connected TM‐C100 printer is not powered, a dialog box shown below appears and 
the icon is displayed in red. 

Status Viewer icon

Dialog box Status Viewer icon
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When Not using the Status Viewer
When you do not need to use the Status Viewer, disable its automatic activation. Right click on 
the Status Viewer icon on the task tray, and select [Status Viewer Settings] to display the setting 
dialog box. 

 Select the [Start‐up options] tab and uncheck the checkbox for ʺAuto run when loginʺ. 

• The automatic activation setting is applied to all users. This setting cannot be changed 
among the users.

• Changing the automatic activation setting is limited to the administrator privilege user. 
• When UAC is enabled on a Windows 7 / Vista based computer, the UAC prompt will be 

displayed.

Status Viewer Settings dialog box
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Viewing the Status Viewer dialog box

Select [Utility] tab in the Printing Preferences screen, and click [EPSON Status Viewer] to display 
the Status Viewer dialog box. Opening or closing the dialog box can be made by the login user. 
On the dialog box, you can check the current printer status and ink information. 

The Status Viewer dialog box also can be opened by the following methods.

• By clicking the icon on the task tray. 

• By right clicking on the icon on the task tray, and selecting [EPSON TM‐C100]. 
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Error / Warning / Status notification

The Status Viewer provides notification when it detects specified printer status, or error or 
warning status. The notification is made by color of the icon on the task tray, and the dialog / 
balloon. For information on what statuses can be notified, see ʺStatus Viewer Settingsʺ on page 
41.
While the Viewer dialog box is displayed, the dialog / balloon are not displayed. 

Icon
A printer status is notified by color of the icon on the task tray as shown below. 

Dialog
When ʺDialogʺ has been selected on [Status Viewer Settings], a dialog box is displayed when any 
of the specified printer statuses, or error / warning statuses occurs. In the dialog box, a line 
appears between the different types of statuses. 

Icon Status Explanation

Normal The printer is ready for printing. 

Status Indicates a status of the printer. For information 
on what statuses can be notified, see ʺStatusʺ 
on page 43.

Warning The printer is not ready for printing or the 
remaining amount of ink is low. For more details, 
see ʺWarningʺ on page 42.

Error The printer has a trouble and cannot perform a 
print job. For more details, see ʺErrorʺ on page 
41.
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Balloon
When ʺBalloonʺ has been selected on [Status Viewer Settings], a balloon message is displayed 
when any of the specified printer statuses, or error / warning statuses occurs. The balloon 
message appears above the icon on the task tray. 
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.

Reference
This chapter explains about print settings available with the TM‐C100 printer driver. 
To open the setting screen of the printer driver Properties, right click the printer driver from 
[Start] ‐ [Control Panel] ‐ [Printers] and select [Properties] (Reference page of other OS.).  
Select the [General] tab on the Properties screen and click the [Printing Preferences...] button to 
open the Printing Preference screen.

Properties Printer driver configuration screen
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Print Settings
The following print settings are available on the TM‐C100 Printing Preferences screen.

Tab Description

Main
Paper type, color setting, mode setting, ink information display setting, and 
print preview setting can be made. 

Paper
Paper feed setting, auto-cutter setting, paper size/page size, number of 
copies, and print area or roll paper option setting can be made. 

Layout
You can adjust the printing position and can set the print orientation and the 
scales of reduction/enlargement here.

Option
You can set the paper feed option, printer model and units of length, and 
can store the print settings here.

Utility You can run provided utilities such as nozzle check from here.  

Version Version information is displayed.
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Main

Paper type, color setting, mode setting, ink information display setting, and print preview 
setting can be made. 

When the setting items displayed do not match with your printer model, the [Printer Color 
Specification] setting on the [Option] tab is wrong. Correct the setting referring to ʺOptionʺ 
on page 32.

Setting Description

Media Type

Select a paper type to use for printing. 

"Plain Paper", "Special Fine Paper", or "Special Matte Paper" can be 
selected. (When the [Printer Color Specification] setting on the 
[Option] tab has been set to "Black", this Media Type setting is fixed to 
"Monochrome".)

Color

Select "Color" for making color print. Select "Monochrome" to print 
using a single color (black is used as default). (When the [Printer Color 
Specification] setting on the [Option] tab has been set to "Black", this 
Media Type setting is fixed to "Monochrome".)
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Print Preview screen
When the Print Preview function is enabled, a print preview screen reflecting the current print 
settings is displayed and you can check the print result before printing. 

Mode

Select a desired print mode. 

Quality/ 
Speed

Select "Quality" or "Speed." Selecting "Quality"gives better print results, 
but it reduces the print speed.

 (When the [Printer Color Specification] setting on the [Option] tab 
has been set to "Black", the print mode is fixed to "Speed".)

Bright/Dark

This setting affects mainly the midtones and does not affect the bright 
(highlight) and dark (shadow) parts as much.

This setting affects mainly the midtones and does not affect the bright 
(highlight) and dark (shadow). You can set to the three levels of 
brightness, "Bright", "Medium (center)", or "Dark" parts as much.

(When the [Printer Color Specification] setting on the [Option] tab has 
been set to "Black", this setting is fixed to "Medium (center)".)

Ink Information

Gives information about the level of ink remaining in the printer.

The ink information does not appear in the following cases.

• When the printer is offline.

Print Preview

Select whether to display a print preview or not. 

When this checkbox is checked, you can preview your print image 
before printing. 

If you are using a Windows 7 / Vista, this function cannot be used unless the login user has 
the administrator privilege.

Setting Description

(1)

(2)

(3)

(4)

(5)

(6)

(7)

(8)

(9)

(10)
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Menu command selection Description Icon
— Select object. (1)

[File] → [Print Document] Print the document. (8)

[File] → [Cancel Print Job] Cancel the print job. (9)

[View] → [Show Toolbars] → 
[Standard]

Show or hide the standard toolbar (1 to 7). —

[View] → [Show Toolbars] → [Print] Show or hide the print toolbar (8 and 9). —

[View] → [Printable Area] Show or hide the printable area. (5)

[View] → [Zoom] → [Fit To Screen] Enlarge or reduce the print preview to match the 
screen size.

(3)

[View] → [Zoom] → [Maximum 
Zoom]]

Zoom to the maximum. (4)

[View] → [Zoom] → [Zoom In]/[Zoom 
Out]

Enlarge or reduce the print preview by right-
clicking or clicking the print preview.

(2)

[View] → [Magnify] Display the magnify dialog box. —

[View] → [Next Page] Display the next page if there are multiple pages 
for printing.

(7)

[View] → [Previous Page] Display the previous page if there are multiple 
pages for printing.

(6)

[View] → [Go To] Go to a specific page if there are multiple pages 
for printing.

(10)

[Print Options] → [Remove Page] Do not print the page being displayed. —

[Print Options] → [Add Page] Print the page being displayed. —

<Magnify dialog>

[View]→[Magnify]
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Paper

Paper feed setting, auto‐cutter setting, paper size/page size, number of copies, and print area or 
roll paper option setting can be made. (The setting items change depending on the option 
selected in [Paper Source Option] on the [Option] tab.)

❏ When ʺAuto Sheet Feederʺ is selected in [Paper Source Option]

• When the setting items displayed do not match with your printer option, the [Paper 
Source Option] setting on the [Option] tab is wrong. Correct the setting referring to 
"Option" on page 32.

• Do not make the paper feed setting on your application side.

Setting Description

Paper Source
Select a desired paper feed method.  

"Auto-Sheet Feeder" or "Manual Feed Slot" can be selected. 

Auto Cut
Cutting method can be specified. 

The auto-cutter is fixed to "None". 
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Paper Size

Select a paper size from the list.

All the physical and logical paper sizes supported by the printer 
driver and user defined size option are displayed as a list.  

Paper size The paper sizes which can be loaded on the printer.

Logic paper 
size

The original paper size which can be scaled down by the printer 
driver. 

The original image is scaled down so that it fits within the width of 
paper loaded on the printer.

User Defined  
Paper Size

The paper size defined by the users. 

You can specify the paper length and width within the allowable 
range. 

Copies

Copies
Specify the number of copies to print. The number must be in the 
range of 1 to 999.

Collate
For a document with multiple pages, the pages are collated when 
printed.

Reverse Order The printing order is reversed, starting from the last page first.

Printable  
Area

Printable area can be specified. 

(When "Plain Paper" is selected in [Media Type] and "Speed" is 
selected in [Mode] on the [Main] tab, this setting is fixed to 
"Standard". )

Standard Printing is possible up to a width of 113.3 mm.

Maximum
Printing is possible up to a width of 109 mm in speed mode, and up to 
a width of 114 mm in normal or fine mode.

Centered
Specify whether to center the print data on the page (vertically and 
horizontally) for printing.

Setting Description
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❏ When ʺRoll Paper Holderʺ is selected in [Paper Source Option]

Setting Description

Paper Source

Select a desired paper feed method.  

However, in this case, this setting is fixed to "Roll Paper 
Holder". 

Auto Cut

Select a cutting method. If you select "No Cut," the paper 
is not cut automatically.

Frequency Cut
Paper is cut per unit number of pages specified. ("Cut per" 
on page 26)

last cut
Paper is cut after printing of the last page has been 
completed.

Frequency Cut

＋ last cut

Paper is cut per unit specified, and the last page is also cut 
after printing has been completed. ("Cut per" on page 26)

Cut per

Specify the unit of pages to cut.

If you specify “1”, paper is cut after each page has been 
printed.

Select either "Frequency Cut" or "Frequency Cut ＋ last cut" 
from [Auto Cut].
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Paper Size

Select a paper size from the list.

All the physical and logical paper sizes supported by the 
printer driver and user defined size option are displayed as 
a list.  

Paper size The paper sizes which can be loaded on the printer.

Logic paper size

The original paper size which can be scaled down by the 
printer driver. 

The original image is scaled down so that it fits within the 
width of paper loaded on the printer.

User Defined 
Paper Size

The paper size defined by the users. 

You can specify the paper length and width within the 
allowable range. 

Copies

Copies
Specify the number of copies to print. The number must be 
in the range of 1 to 999.

Collate
For a document with multiple pages, the pages are 
collated when printed.

Reverse Order
The printing order is reversed, starting from the last page 
first.

Roll Paper Option

Banner Mode
In this mode, no margins are set in the top and bottom of 
the page. If the autocutter is enabled, the roll paper is cut 
after all printing is finished.

Cut-Sheet Mode
In this mode, margins are set in the top and bottom of the 
page. If the autocutter is enabled, paper is cut after each 
page.

Save roll paper

Select this check box if you want to save roll paper by 
removing the extra space at the bottom of a document.

When "Cut-Sheet Mode" is enabled, select the Save roll 
paper option from "Don’t save", "ALL Page Save", or "End 
Page Save". 

Print page frame

Select this checkbox if you want to print a dotted line at 
the end of each page after data is printed.

This setting item is not displayed when "Banner Mode" is 
selected.

When you specify "End Page Save" from [Save roll paper] in [Roll Paper Option]-[Cut-
Sheet Mode], go to the [Advanced] tab in [Properties] and check "Start printing after last 
page is spooled."

Setting Description
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❏ When ʺNoneʺ is selected in [Paper Source Option]

Setting Description

Paper Source
Select a desired paper feed method.  

However, in this case, this setting is fixed to "Manual Feed Slot". 

Auto Cut
Cutting method can be specified. 

However, in this case, the auto-cutter setting is fixed to "None". 

Paper Size

Select a paper size from the list.

All the physical and logical paper sizes supported by the 
printer driver and user defined size option are displayed as a 
list.  

Paper size The paper sizes which can be loaded on the printer.

Logic paper size

The original paper size which can be scaled down by the 
printer driver. 

The original image is scaled down so that it fits within the width 
of paper loaded on the printer.

User Defined 
Paper Size

The paper size defined by the users. 

You can specify the paper length and width within the 
allowable range. 

Copies

Copies
Specify the number of copies to print. The number must be in 
the range of 1 to 999.

Collate
For a document with multiple pages, the pages are collated 
when printed.

Reverse Order The printing order is reversed, starting from the last page first.
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Paper setting confirmation
When the specified [Paper Size] or [Page Size] is larger than the printable area of the option 
selected in the [Option] tab, the following message is displayed. 

Select an output paper size and click the [OK] button on the dialog box. The automatic enlarging/
reducing function is enabled so that the print image fits within the paper size. 

Printable 
Area

Printable area can be specified. 

(When "Plain Paper" is selected in [Media Type] and "Speed" is 
selected in [Mode] on the [Main] tab, this setting is fixed to 
"Maximum". )

Standard Printing is possible up to a width of 113.3 mm.

Maximum Printing is possible up to a width of 118.6 mm.

Centered
Specify whether to center the print data on the page 
(vertically and horizontally) for printing.

Setting Description
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Setting the user defined size
Users can configure original paper sizes. Use this setting when you want to use a paper size 
other than the preset ones. 
Up to 30 sizes can be saved as the User Defined Paper Size. 
 Select the User Defined Paper Size option in the [Paper Size] setting on the [Paper] tab to display 
the User Defined Paper Size dialog box shown below.  

Setting Description

Paper Size

All the saved User Defined Paper Sizes are displayed in a list. 

To add a new size setting, select "User Defined Size". When one of the saved 
sizes is selected from the list, the configured [Paper Size name], [Paper Width], 
and [Paper Length] are displayed and you can edit the settings. 

Save

Click this to save a configured paper size. 
The [Paper Size Name], [Paper Width], and [Paper Length] settings are saved. 

When you edit and save an existing user defined paper size, the settings are 
overwritten. 

Delete Click this to delete a paper size selected in the list.

Paper Size Name

Each of the user defined paper size settings can be saved under a desired 
name. Up to 24 characters can be used for the name. 

You cannot use the names of the physical paper sizes, which are already used 
in the preset paper size list on the [Layout] tab.

Paper Width Specify a desired paper width. 

Paper Length Specify a desired paper length.

OK The selected User Defined Paper Size is accepted as the paper size. 

Cancel Changes made on a User Defined Paper Size setting is canceled. 
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Layout

You can adjust the printing position, and can set the orientation and the scale of reduction/
enlargement for print data.

If the Fit to Page feature is enabled, this check box is selected and cannot be changed. 
(ʺPaper setting confirmationʺ on page 29)

Setting Description

Printing 
position 
adjust-
ment

You can adjust the printing position through this printer driver without 
modifying the application.

Vertical 
direction

Set this to move the printing position in the vertical direction. The 
addressable range depends on the paper size. The printing position moves 
downward when you specify a positive value, and it moves upward when 
you specify a negative value.  

Horizontal 
direction

Set this to move the printing position in the horizontal direction. The 
addressable range depends on the paper size. The printing position moves 
to the right when you specify a positive value, and it moves to the left 
when you specify a negative value.

Orienta-
tion

Portrait Select this for portrait printing.  

Landscape Select this for landscape printing.  

Rotate by 
180º

Rotate 180º and then print.

Reduce/Enlarge Check this checkbox to enable the enlarging/reducing settings. 

Fit to Page*
Select this option to automatically reduce or enlarge print data to fit to the 
page of the paper size selected from the combo box.
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* In this case, the scale ratio is calculated not from the paper size but the printable area. Therefore, even if you 
select the same size as the output paper, the scale ratio is smaller than 100%.

Option

You can set the paper feed option, printer model and units of length, and can store print settings.

Custom

Select a paper size from the combo box and specify the scale ratio to a 
value from the range of 10 to 400%, in 1% increments. If you specify a value 
less than 100%, the print data is reduced. If you specify a value greater 
than 100%, the print data is enlarged.

Output Paper Select a paper or page size to be output from the preset list. 

Scale to Specify a desired scale of enlargement/reduction. 

Setting Description

Paper Source Option
Select an option paper feeder to use. "Auto-Sheet Feeder", "Roll Paper 
Holder", or "None" can be selected. 

Printer Color 
Specification

Select the printer model to use. Select either "Color" or "Black". 

Switch 
properties 
with each 
paper Size

Enable
Press the [Apply] button to store the present print settings in [Page Size] 
presently specified. Specify [Page Size] to reflect the stored print settings.

Disable
Selecting this prohibits switching the print settings by the page size.

Units of length Select either "millimeter" or "inch" to switch the units of length.

Setting Description
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Retry Printing
If printing stops in the middle because the printer cover was open/the FEED button was pressed/
the RELEASE button was pressed/the printer power was cut off/the paper has ended, printing 
resumes from the beginning of the page where printing stopped.

Retry 
Printing

Enable
When printing stops in the middle due to an error or printer power-off, 
printing resumes from the beginning of the page where printing 
stopped.

Disable
When printing stops in the middle, printing resumes, with the page where 
printing stopped omitted.

Setting Description

Printing data Enable Disable

Page 1

Page 2

Page 3

Suspension 
of printing

Suspension 
of printing

Recovery to printingRecovery 
to printing
Printing data stored in the 
printer buffer

Reprints automatically 
beginning with the page 
that failed to print.

Printing data stored in the printer buffer 
(Printing content differs depending on the 
printer status. Printing may not be performed if 
the printer is turned off and on when printing 
stops.)

Reprints manually from 
the application.
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Utility

You can run provided utilities. For more details about the utilities, see ʺUtilityʺ on page 37.

Setting Description
EPSON Status Viewer Use this utility to display error information and the level of ink remaining.

Nozzle Check Use this utility to determine clogged nozzles on the print head.

Head Cleaning Use this utility to clean the nozzles on the print head.

Top-Margin Correction Use this utility to adjust any misaligned top margins of your printouts.

Right-Margin Correction Use this utility to adjust any misaligned right margins of your printouts.

Adjust LR Utility Use this utility to adjust misaligned vertical lines in your printouts.
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Version

The version of the printer driver is displayed. 
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Utility
The TM‐C100 printer driver offers the following utilities. 
This chapter explains about each of the utilities. 

• EPSON Status Viewer Utility: Use this utility to display error information and the level         

of ink remaining.

• Nozzle Check Utility: Use this utility to determine clogged nozzles on the         

print head.

• Head Cleaning Utility: Use this utility to clean the nozzles on the print head.

• Top-Margin Correction Utility: Use this utility to adjust any misaligned top margins of         

your printouts.

• Right-Margin Correction Utility: Use this utility to adjust any misaligned right margins of         

your printouts.

• Adjust LR Utility: Use this utility to adjust misaligned vertical lines in your         

printouts.
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EPSON Status Viewer
EPSON Status Viewer allows you to monitor the printer status and to be notified of specified 
statuses such as error and ink information. The printer status can be checked anytime on the 
Status Viewer dialog box and the notification function is available in two ways; showing the 
statuses using a dialog box or balloon. 

Activating manually and quitting

The Status Viewer is automatically activated, however, you can also manually activate and quit 
it. 

Activating the Status Viewer manually
When the Status Viewer is not activating, you can activate it manually using one of the following 
methods. 

• Click the [Status Viewer] button on the [Utility] tab. 

Quitting the Status Viewer
You can quit the Status Viewer in the following way. 
Right click on the EPSON Status Viewer icon, and select [Quit Status Viewer]. 

Status Viewer icon

While the Status Viewer is activating, the icon is displayed on the task tray. 
The color of the icon changes depending on the printer status. 

Status Viewer icon
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Viewer dialog box

The Viewer dialog box shows you the current printer status, and cartridge / ink information. 

Printer ready status
Whether the printer is ready for printing or not can be checked as shown below. 

Status Icon Character display

Normal

Printing is ready.

Status

Warning

Error Printing is not ready.

Cartridge Information

Printing preparation state

Status information
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Status information 
The printer statuses including warning/error statuses are displayed for each of the status items 
specified to be notified. For information on what statuses can be notified, see ʺStatus Viewer 
Settingsʺ on page 41.
In the dialog box, a line appears between the different types of statuses. (Classified in Error / 
Warning / Status categories.)

Cartridge information / Ink information
The cartridge information graphs out the current ink level of each cartridge. You can hide the 
information by clicking the [Cartridge Information] button. To display the information, click the 
[Cartridge Information] button again. 
 Click the [Ink Details] button to display the ink information list. The ink information shows ink 
type, date manufactured, model, and maker. 

The ink level graph and the [Cartridge Information] button are not displayed while the printer is 
offline or no response is coming from the printer. 

Cartridge Infomation 
button

Ink information window

Ink Details button
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Status Viewer Settings

In the Status Viewer Setting screen, you can specify statuses (Error, Warning, Status) to be 
notified, and select whether to activate the Status Viewer automatically or not. 
To display the Status Viewer setting dialog box, right click on the icon on the task tray, and select 
[Status Viewer Settings]. 

Error
An ʺErrorʺ status indicates that the printer has a trouble and cannot perform a print job. On this 
[Error] tab, you can select which and how error statuses you are notified of.

Setting Default Explanation

Notification 
items

-
All the status items checked here are 
notified using a dialog box or balloon. 

No response from 
printer

Check ON
Notify when no response is coming from the 
printer.

Off-line Check ON Notify when the printer becomes offline.

Printer Cover open Check ON Notify when the printer cover is opened. 

Mechanical error Check ON Notify when a mechanical error occurs.

Autocutter error Check ON Notify when an auto-cutter error occurs.

Critical error Check ON Notify when an unrecoverable error occurs.

Auto-recoverable error Check ON
Notify when an automatically recoverable 
error occurs.

No Ink Cartridge Check ON Notify when no ink cartridge is detected.

Replace Ink Cartridge Check ON
Notify when ink cartridge needs to be 
replaced.
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Warning
A ʺWarningʺ status indicates that the printer mechanism itself does not have a trouble, but 
cannot perform a print job or the remaining amount of ink is low. On this [Warning] tab, you can 
select which and how warning statuses you are notified of.

Notification 
Settings

Notification Method Dialog
You can select "Dialog" or "Balloon" to 
display the status.

Notification Position Center

If "Dialog" is selected, you can further 
specify where on the screen to display the 
dialog box. You can select [Top], [Center], 
or [Bottom].

Duration of 
Notification

0

Specify an interval from the range of 0 to 
999, in seconds, to use to display the status 
again after it is displayed. If you set the 
interval to 0, the status is not displayed 
again until it changes.

Setting Default Explanation

Notification 
items

-
All the status items checked here are 
notified using a dialog box or balloon. 

No paper Check ON Notify when no paper is detected.

Release Lever open Check ON
Notify when the release lever is in its lowest 
position.

Ink low Check ON
Notify when the remaining amount of ink 
becomes low.

Setting Default Explanation
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Status
A ʺStatusʺ indicates a status of the printer operation. On this [Status] tab, you can select which 
and how statuses you are notified of.

Notification 
Settings

Notification Method Balloon
You can select "Dialog" or "Balloon" to 
display the status.

Notification Position -

If "Dialog" is selected, you can further 
specify where on the screen to display the 
dialog box. You can select [Top], [Center], 
or [Bottom].

Duration of Notification 0

Specify an interval from the range of 0 to 
999, in seconds, to use to display the status 
again after it is displayed. If you set the 
interval to 0, the status is not displayed 
again until it changes.

Setting Default Explanation

Notification 
items

-
All the status items checked here are 
notified using a dialog box or balloon. 

Feeding paper/Paper 
feed finished

Check OFF
Notify when paper feeding is in progress 
and when the feeding is finished.

Feed Button pressed 
/Feed Button not pressed

Check OFF
Notify when the feed switch is turned on or 
off.

Paper at TOF Sensor 
/No paper at TOF Sensor

Check OFF
Notify when the TOF sensor detected 
paper or not detected.

Paper at BOF Sensor 
/No paper at BOF Sensor

Check OFF
Notify when the BOF sensor detected 
paper or not detected.

Paper Type: Roll paper 
/Cut paper

Check OFF
Notify when the paper type is changed to 
roll paper or cut sheet.

Cut paper: 

Manual paper feeder 
/Auto sheet feeder

Check OFF
Notify when the paper feeder for cut 
sheets is changed to manual or ASF.

Cleaning 
/Cleaning finished

Check OFF
Notify when a cleaning is in progress and 
when it is finished.

Setting Default Explanation
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Start-up options
Select whether to automatically activate the Status Viewer or not when you login the computer. 

Notification 
Settings

Notification Method Balloon
You can select "Dialog" or "Balloon" to 
display the status.

Notification Position -

If "Dialog" is selected, you can further 
specify where on the screen to display the 
dialog box. You can select [Top], [Center], 
or [Bottom].

Duration of Notification 0

Specify an interval from the range of 0 to 
999, in seconds, to use to display the status 
again after it is displayed. If you set the 
interval to 0, the status is not displayed 
again until it changes.

Setting Default Explanation

Auto run when login Check ON
When checked, the Status Viewer automatically 
starts to run when you login the computer. 

Setting Default Explanation



Chapter 4   Utility

45

4

Nozzle Check Utility 
The Nozzle Check utility prints a nozzle check pattern. By examining the nozzle check pattern, 
you can detect whether the nozzles on the print head are clogged.
Use the following procedure to check the nozzles on the print head.

1 Turn on the power of the printer.

2 Load paper. (For information on how to load paper, refer to the "TM-
C100 User's Manual" supplied with the printer. For information on how to 
set up the paper source, see "Paper" on page 24.)

3 From the [Utility] tab, click [Nozzle Check]. The following message 
appears.

4 Click [Next]. A nozzle check pattern is printed.

5 After the nozzle check pattern is printed, the following message 
appears.
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6 If the nozzle check pattern does not appear incomplete, this indicates 
the nozzles on the print head are normal. Click [Finish] to exit this utility.
If the nozzle check pattern appears incomplete, this indicates the nozzles on the print head are               
clogged. Click [Clean Head] to perform print head cleaning.
(For information on how to clean the print head, see "Head Cleaning Utility" on page 47)

<Printing example where nozzles are clogged><Normal printing example>

Some lines are not printed.
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Head Cleaning Utility 
The Head Cleaning utility enables you to clean nozzles on the print head of the printer. 
To perform print head cleaning, use the following procedure.

1 Turn on the power of the printer.

2 From the [Utility] tab, click [Head Cleaning]. The following message 
appears.

3 Click [Next]. Print head cleaning starts.

4 When print head cleaning is finished, the following message appears.

To see if the print head has been cleaned successfully, click [Check Nozzle] to print 
a nozzle check pattern. (For information on nozzle check, see "Nozzle Check Utility" 
on page 45.)

The print head cleaning operation removes anything blocking the nozzles and therefore 
prevents the nozzles from clogging up. Because this operation also removes some ink, it 
should not be used unless necessary.
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Top-Margin Correction Utility 
The Top‐Margin Correction utility enables you to print a test page and correct any top margin 
misalignment problem.
Use the following procedure to correct a top margin misalignment problem.

1 Remove the Roll Paper Holder if it is installed on the printer.

2 Turn on the power of the printer.

3 Manually load paper of A6 or larger size.

4 From the [Utility] tab, click [Top-Margin Correction]. The following 
message appears.

To correct the top margin misalignment problem, be sure to always use paper of A6 or 
larger size, and set the paper source to "Manual Feed Slot"; if you use any other 
combinations, the printer still works but the print result is not guaranteed. (For information 
on how to load paper, refer to the "TM-C100 User's Manual" supplied with the printer. For 
information on how to set up the paper source, see "Paper" on page 24.)
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5 Click [Next]. A test page is printed by using the current top margin 
position correction value, and the following message appears.

6 Check the print result. If correction is required, enter a new top margin 
position and then click [Retry]. Another test page is printed by using the 
new top margin position, and the same message appears. Repeat 
these steps until the correct top margin is obtained.

7 After the top margin correction value is determined, click [Save and 
Exit]. The top margin correction value is saved and correction is 
completed.

Printing 
direction

Check the number appearing at the top 
of the fan object. Enter this number. In this 
example, entering -6 will correct the 
problem and the top margin will be 
printed in the correct position, as shown 
in the figure on the right.

<Print result example: where top margin correction is required> <Print result example: where top margin position is correct>

The number at the top 
edge of paper is 0.
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Right-Margin Correction Utility 
The Right‐Margin Correction utility enables you to print a test page and correct a right margin 
misalignment problem.
Use the following procedure to correct a right margin misalignment problem.

1 Remove the Roll Paper Holder if it is installed on the printer.

2 Turn on the power of the printer.

3 Manually load paper of A6 or larger size.

4 From the [Utility] tab, click [Right-Margin Correction]. The following 
message appears.

To correct a right margin misalignment problem, be sure to always use paper of A6 or larger 
size, and set the paper source to "Manual Feed Slot"; if you use any other combinations, 
the printer still works but the print result is not guaranteed. (For information on how to load 
paper, refer to the "TM-C100 User's Manual" supplied with the printer. For information on 
how to set up the paper source, see "Paper" on page 24.)
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5 Click [Next]. Two patterns (patterns #1 and #2) are printed by using the 
current LR position correction value, and the following message 
appears.

6 Check patterns #1 and #2 in the print result. If correction is required, 
enter the new position correction values and then click [Retry]. The two 
patterns are printed again, and the same message appears. Repeat 
these steps until the correct right margin is obtained.

7 After the right margin correction value is determined, click [Save and 
Exit]. The right margin correction value is saved and correction is 
completed.

Printing 
direction

Check the number 
appearing at the right 
side of the fan object. 
Enter this number. In this 
example, entering -2 will 
correct the problem and 
the right margin will be 
printed in the correct 
position, as shown in the 
figure on the right.

<Print result example: where right margin 
correction is required>

The number at the right 
edge of paper is 0.

<Print result example: where right margin 
position is correct>
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Adjust LR Utility 
The Adjust LR utility enables you to print a test page and then adjust any printing misalignment.
Use the following procedure to correct a printing misalignment problem.

1 Turn on the power of the printer.

2 Load paper. (For information on how to load paper, refer to the "TM-
C100 User's Manual" supplied with the printer. For information on how to 
set up the paper source, see "Paper" on page 24.)

3 From the [Utility] tab, click [Adjust LR]. The following message appears.

4 Click [Next]. Two patterns (patterns #1 and #2) are printed by using the 
current LR correction value, and the following message appears.
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5 Check patterns #1 and #2 in the print result. If correction is required, 
enter the new LR correction values and then click [Retry]. The two 
patterns are printed again, and the same message appears. Repeat 
these steps until the correct LR correction value is obtained.

6 After the LR correction value are determined, click [Save and Exit]. The 
LR correction values are saved and correction is completed.
If roll paper is used, after the correction, paper is automatically fed and cut, and              
the paper is advanced to the top margin position of the roll paper.

Printing 
direction

Find the number of the upper 
and lower lines that form a 
straight line. Enter this number 
as the LR correction value. In 
this example, entering 2 will 
correct the problem and the LR 
position will be printed 
correctly, as shown in the figure 
on the right.

<Print result example: where LR correction is required> <Print result example: where LR position is correct>

Upper line 0 and lower line 0 
become a straight line.
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PRINTER_INFO_2
This chapter explains printer information acquired by PRINTER_INFO_2.
APD allows you to acquire printer information by using PRINTER_INFO_2.

TM PRINTER_INFO_2.Status Converting Table
The PRINTER_INFO_2 structure specifies detailed printer information. In this member, you can 
acquire the following TM printer statuses.

PRINTER_INFO_2 Status of TM-printer

PRINTER_STATUS_BUSY not available

PRINTER_STATUS_DOOR_OPEN 1.When the paper roll cover is open.
2.When the carriage cover is open.

PRINTER_STATUS_ERROR not available

PRINTER_STATUS_INITIALIZING During the printer initializing.

PRINTER_STATUS_IO_ACTIVE not available

PRINTER_STATUS_MANUAL_FEED Feeding paper by the paper feed switch.

PRINTER_STATUS_NO_TONER Ink cartridge is not installed or replace Ink cartridge.

PRINTER_STATUS_NOT_AVAILABLE 1.Power is not stable.
2.The interface cable is not connected.

PRINTER_STATUS_OFFLINE 1.Between when the power is turned on or the printer is reset and 
when the printer becomes ready to receive data.

2.Between when the printer becomes ready to receive data and 
when the printer mechanism is finished initializing.

3.During the self-test.

PRINTER_STATUS_OUT_OF_MEMORY not available

PRINTER_STATUS_OUTPUT_BIN_FULL not available

PRINTER_STATUS_PAGE_PUNT not available

PRINTER_STATUS_PAPER_JAM not available

PRINTER_STATUS_PAPER_OUT When an empty paper supply is detected by the paper roll end 
detector.

PRINTER_STATUS_PAPER_PROBLEM not available

PRINTER_STATUS_PAUSED not available

PRINTER_STATUS_PENDING_DELETION not available

PRINTER_STATUS_POWER_SAVE not available

PRINTER_STATUS_PRINTING While when StartDoc is executed and the status of printing 
completed is returned by the printer.

PRINTER_STATUS_PROCESSING not available

PRINTER_STATUS_SERVER_UNKNOWN not available

PRINTER_STATUS_TONER_LOW The ink low is detected.
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PRINTER_INFO_2 Status of TM-printer

PRINTER_STATUS_USER_INTERVENTION An error has occurred.
 1.Printing on the paper roll is not performed correctly due to a 

cover-open.
 2.Print head temperature error 
 3.The autocutter does not work correctly.
 4.The home position cannot be detected due to a paper jam.
 5.The carriage is out of phase.
 6.The cut sheet cannot be ejected even if a certain amount of 

feeding is tried.
 7.The CPU on the printer executes an incorrect address or the I/F 

board is not connected.
 8.After R/W checking, the printer does not work correctly
 9.The power supply voltage is extremely high.
10.The power supply voltage is extremely low.
11.Internal circuit does not work correctly.
12.UIB does not work correctly. 

PRINTER_STATUS_WAITING not available

PRINTER_STATUS_WARMING_UP not available
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Specification
This chapter explains the specification of the TM‐C100 printer driver.

TM-C100

Administrator permission is required for property settings of the printer driver.

Item Description
Driver Name EPSON TM-C100

Device Font Not supported

Barcode Font Not supported

2D-Code Font Not supported

Control Font Not supported

ControlA Font Not supported

Resolution 180 x 180DPI, 360 x 180DPI, 360 x 360DPI

Paper Size Roll Paper
76mm x 297mm
90mm x 297mm
105mm x 297mm
Postcard
100mm x 148mm
A6
105mm x 148mm
A4
210mm x 297mm
LT. 8.5 x 11 in.
User Defined Paper Size
49mm - 35mm x 85mm - 210mm

80mm
Logic paper size 80mm x 297mm (566dot x 2104dot)
Printable Area 72.2mm (512dot)
Margin Top 0

Left 3.6mm(26dot) Right 3.9mm(28dot)
User Defined Paper Size

Paper Width 72.2 - 210mm, Paper Lengh 25.4 - 3276.0mm
Logic paper size

A4 210mm x 297mm
LT. 8.5 x 11 in.
Postcard 100mm x 148mm

Rotate Normal Rotate by 90 Degrees
Rotate by 180 Degrees Rotate by 270 Degrees

Reduce Printing ON/OFF
Fit to Printable Width/Custom(10 - 100%)

Water Mark Not supported
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